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Key Enterprise Elements
Managing the Enterprise Portfolio to Maximize Mission Impact

Keeping our focus on the most important dimensions of the Enterprise Total Solution Package

Strategic 

Drivers

Strategic & 

Enterprise 

Challenges

Capabilities 

& Effects

Portfolio & 

Solution Elements

Enterprise 

Missions & Initiatives

Operational 

Performers & Activities

✓ Enterprise Goals & Objectives

✓ National Priorities & Initiatives

✓ Treaties & Agreements

✓ Laws & Regulations

✓ Social & Cultural Expectations
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Portfolio Management Examines Cost versus Effectiveness
What Capabilities and Operations lead to improved Outcomes?
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• Enterprise Concepts

– Enterprise vs System

– Enterprise Transformation

– Drivers and Outcomes

– Portfolio Management

• Architecture Modeling

– Modeling Landscape

– Modeling Languages

– Enterprise Modeling Ontology

– Architecture Views & Viewpoints

• Unified Architecture 

Framework (UAF)

– UAF Specification

– Architecture Modeling Workflow

– Framework Grid

• Stakeholder Perspectives

• Architectural Facets

• Architecting Workflow

– Workflow Steps

– Architecture Views

Topics
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Systems vs. Enterprises

Outputs for a System tend to be the same over its lifetime. But Outcomes for an Enterprise are very complex 

and are shifting over time. Usually a “sequence” of Outcomes will be laid out in a Roadmap.

EnterpriseDRIVERS OUTCOMES

SystemINPUTS OUTPUTS
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System Architecture is Like 

Blueprints for a Building

Outputs for a System tend to be the same over its lifetime. The requirements are established 

early on and tend not to change very much. Results for a system are more readily predicted. 
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Enterprise Architecture is More Like 

Urban Planning

Outcomes for an Enterprise are very 

complex and are shifting over time. 

Usually a “sequence” of outcomes is 

laid out in a roadmap. The Enterprise 

can change its own objectives!
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Change in Focus From Control to Intervention…

Source: Evolution Toward Engineering Complex Systems, Joseph DeRosa, MITRE, 

Complex Conference, Brisbane, Australia, 2007 (Used with permission)

Static: As Is – To Be Views

Passive: One Design Choice

Uniform: All Parts Are Equal

The Watchmaker:  
Everything has its place…

Traditional Systems Engineering

Dynamic: Constant Change

Competitive: Crops compete

Scale Free: 80-20 Rule 

The Gardener:  
Plant, Fertilize, Weed → Repeat

Enterprise  Systems Engineering
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Transforming the Enterprise to Achieve Desired Outcomes
Finding the Optimal States and the Right Processes

Architecture Models can help understand the landscape and how to change things for the better

Drivers

• Demand
• Competition
• Laws
• Regulations
• People
• Technology
• Investment
• Revenues

Outcomes

• Products
• Services
• Revenues
• Earnings
• Share Price
• Market Share
• Jobs
• Innovation

Enterprise 
State

Work 
Processes
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Portfolio Management

DRIVERS OUTCOMES

Portfolio (Current) Portfolio (Future)

Has Desires

Enterprise
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Modeling 

Language

Architecture 

Framework

Modeling 

Profile

Modeling 

Methodology
Modeling 

Patterns

Modeling 

Templates

• Viewpoints

• View Specifications

• Domain Metamodel

• Syntax

• Notation

• Semantics

Architecture 

Models Architecture 

Views

Modeling 

Workflow

Architecture 

Description

The Modeling Landscape
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OMG Modeling Standards
Modeling Languages

For modeling complex software 

architectures and applications

For modeling complex system architectures

that may include hardware, software, personnel, 

processes, and facilities

For modeling complex business processes

for business process re-engineering initiatives, 

process maturity improvement, cycle time 

reduction, and business integration efforts

For modeling complex enterprise 

architectures that includes strategy, 

operations, programs/projects, services, 

resources, security, personnel, 

organizations and standards
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• Enterprise Modeling
– Unified Profile for DODAF & MODAF (UPDM)

• High-level modeling language based on UML and SoaML modeling constructs 

applied to DODAF views

– Unified Architecture Framework (UAF) Profile

• Based on SysML, BPMN, SoaML applied to UAF views (including DODAF views)

• Includes Domain Metamodel (DMM) that fixes various DODAF shortcomings

• Evolved from UPDM and was originally known as UPDM v3

• Systems Modeling
– Systems Modeling Language (SysML)

– Architecture & Analysis Design Language (AADL)

• Software Modeling 
– Unified Modeling Language (UML)

– Various extensions to UML 

• MARTE profile for real-time and embedded systems

• And other UML profiles for XSD schema definition, web modeling, 

business process modeling, open distributed processing, etc

Modeling Languages are key enablers for Digital Engineering and for Architecture and other SE practices

Modeling Languages for Different Levels
Using Modeling Languages to characterize the problem and solution spaces
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Unified Architecture Framework (UAF) Views
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UAF Views & Models
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Modeling 

Language

Architecture 

Framework

Modeling 

Profile

Modeling 

Methodology
Modeling 

Patterns

Modeling 

Templates

• Viewpoints

• View Specifications

• Domain Metamodel

• Syntax

• Notation

• Semantics

Architecture 

Models Architecture 

Views

Modeling 

Workflow

Architecture 

Description

Ontology

EA Guide
Language

Unified Architecture Framework
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UAF Conceptual Schema 
(i.e. Ontology!)
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Modeling 

Methodology

Architecture 

Models Architecture 

Views

Architecture 

Description

✓ Generate views

✓ Basis for analysis

✓ Link Architecture to 

Design Engineering

✓ Check that architecture 

is complete & correct

✓ Capture ASOT data for 

a system or enterprise

✓ Inform Decision Makers

✓ Validate with Stakeholders

✓ Justify budget request & plans

✓ Basis for requirements 

definition & management

✓ Basis for V&V planning and 

execution (eg, test cases)

Primary Use Cases for Architecture Models & Views

* Use cases most relevant 

to Portfolio Management
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How to Model the Enterprise Architecture?
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Modeling 

Language

Architecture 

Framework

Modeling 

Profile

Modeling 

Methodology
Modeling 

Patterns

Modeling 

Templates

• Viewpoints

• View Specifications

• Domain Metamodel

• Syntax

• Notation

• Semantics

Architecture 

Models Architecture 

Views

Modeling 

Workflow

Architecture 

Description

Language 

Metamodel

Domain 

Metamodel

LANGUAGE
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• SysML is great for:

– Modeling Systems and for doing Systems Engineering

– Defining and tracing between levels of abstraction within a System

– Defining the RFLP for a System – Requirements, Functions, Logic & Physical aspects

• The UAF Modeling Language (UAFML) provides all this, plus more:

– Capability and Enterprise concepts: defines the “why” and “what” before the “how”

– Services concepts: definition of Enterprise services (producing and consuming) and 

traceability to capabilities, operations, and implementing resources

– Human Factors: How People and Systems interact, and knowledge & skills

– Security: Identifying risk, mitigation, and integrating security in the Architecture

– Standards: definition of and compliance with standards in the Architecture

– Project Deliveries: phased milestone approach to Capability deployment

– System Configuration over time: deployment and changes

– Tie-in to Requirements Tools: Easy way to link Architecture to Requirements

– Built-in Traceability between multiple views – Between Layers and Across Layers

Why not just use SysML?
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• Security Views: rules and constraints, enclaves and levels, 

threat analysis, security weaknesses and strongpoints

• Personnel Views: roles and responsibilities, knowledge 

and skills, organizational constructs, role dependencies

• Resources Views: kinds of resources (including 

Systems) that can implement functions and activities, 

interactions and dependencies, mapping to requirements

UAF Provides Additional Key Features…
New viewpoints to address other important stakeholders and their concerns



What elements are in my portfolio?

How much value do they deliver?

How are these elements related?

How much cost is involved?
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UAF Basic Building Blocks

ProjectActivity

OperationalActivity

Function

Capability

Actual

EnterprisePhase

Operational 

Role

Actual

Resource

ActualProject

Milestone

Actual

Organisation

Actual

Organisation

Actual

Organisation

Agent

High Level

Need

What (Logical

Analysis)

How (Orgs/ 

Systems)

Delivered 

byPerforms

Performs

Trace to

Implements

Delivers

Exhibits

Resource IF

Known

ResourcePerforms

Behaviour
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What should motivate the Enterprise to change?
Drivers & Challenges as the basis for identification of Opportunities to pursue…
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Conceptual Schema
Modeling of Enterprise Operations 

and their Implementing Resources Resource 

Elements
Operational 

Elements

Implement
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Drivers → Challenges → Opportunities →

Capabilities → Effects → Outcomes

Drivers

• Demand
• Competition
• Laws
• Regulations
• People
• Technology
• Investment
• Revenues

Outcomes

• Products
• Services
• Revenues
• Earnings
• Share Price
• Market Share
• Jobs
• Innovation

Enterprise 
State

Work 
Processes
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Challenges & Opportunities to be Identified for 

Achieving Enterprise Transformation

Drivers

• Demand
• Competition
• Laws
• Regulations
• People
• Technology
• Investment
• Revenues

Outcomes

• Products
• Services
• Revenues
• Earnings
• Share Price
• Market Share
• Jobs
• Innovation

Enterprise 
State

Work 
Processes

Challenges Capabilities

Effects

Opportunities

Risks
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Identification of Capability Gaps and Shortfalls
Focus on Enterprise Capabilities & Desired Effects for Portfolio Management 

Need to examine various factors that will help identify which Capabilities in the Enterprise have 

gaps and shortfalls with respect to causing desired Effects

✓ Drivers

✓ Challenges

✓ Opportunities

Effects

These provide the 

proper justification 

for new & improved 

Capabilities
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The UAF modeling viewpoints facilitate a logical and 

systematic flow of architecting activities

I. Concerns drive a strategic plan

II. The strategic plan deploys capabilities in phases 

addressing gaps and shortfalls

III. Capabilities are implemented by conceptual operations

IV. Concepts are implemented through services, resources 

and personnel

V. Resources comply with standards

VI. Risk and threats are mitigated through security & 

protection controls (of resources and operations)

VII. Requirements are understood 

and communicated

VIII. Plans deliver the resources

IX. Resources are verified

UAF provides a complete set of modeling domains as basis for defining the 
necessary architecture views of an Enterprise that can support Portfolio Management

Progression from Architecture Drivers to Implementation and 

Deployment of Capabilities
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Summary & 

Overview

Standards

Strategic

Operational

Services

Resources

Personnel

Security

Projects

Actual Resources

Iterative Analysis of 

Alternatives and Trades at 

each domain handoff

Verification, Validation and 

Assessment of Implementations

Stakeholders, needs, strategic opportunities, 

driving problems and issues

Strategy, objectives, desired capabilities, 

phasing structure, MOEs and roadmaps

Operational MOPs, taxonomy, activity flows, 

sequences, states, and information exchanges

Service agreements, partnerships, 

and external service dependencies

Physical resources, TPMs, function flows, 

sequences, states, and data exchanges

Standards profile and forecast

Human resources, knowledge and skills, 

positions, roles, and responsibilities

Risks, threats, operational and resource 

mitigations, security enclaves and policies

Integrated deployment schedule 

with delivery milestones

Validation, verification, deployment 

tracking, and use of employed resources

Implementation of 

Operational Elements
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Standardized Enterprise Architecture Workflow in UAF
Establishes a Business Rhythm for Enterprise Transformation activities

Improves coordination and synchronization among the many players involved in Portfolio Management effort
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Changing the Portfolio in Response to New Drivers & Challenges
The Enterprise Architecture serves as the foundation for understanding impact of changes
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Uses and Challenges of Enterprise Architecture

•Uses of an Enterprise Architecture
– Enterprise Risk and Opportunity Assessment

– Program Assessment and Evaluation

– Portfolio Management

– Budget Planning and Execution

– Project Formulation and Planning

– System Requirements Development

•Challenges Likely to be Encountered
– Projects won’t readily give up what they know (information is power)

– Programs have their own spending authority (money is power)

– Architecting an Enterprise demands a different mindset

– Modeling an Enterprise requires different methods and tools

– Easier to just incrementally change way things are done

– The Future never arrives as we had planned…
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Capability Roadmap is Key for Identifying Gaps & Shortfalls

Search & Rescue (SAR) 

Enterprise Architecture 
(from UAF Sample Model)
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Operational Viewpoint Helps Identify Operational Impacts

Search & Rescue (SAR) 

Operational Performers
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Resources Structure View and Resources Roadmap

Search & Rescue (SAR) 

Systems and Other 

Resources
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Projects Viewpoint Ontology

Defines Architecturally-

Significant Resource 

Deliveries Associated with 

Projects & their Milestones
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Projects Taxonomy, Structure & Roadmaps Views
Project deliverables constitute the Capability Configurations on the Capability Roadmap

Search & Rescue (SAR) 

Portfolios & Projects
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System End of Life Before Next Delivery Causes a Capability Gap
Roadmap views provide key insights into Portfolio change impacts

Models can highlight issues and potential problems

Adjusting milestones in 
PV-2 will affect CV-3

Open gap

Capability delivery EOL

PV-2 Project Timelines

CV-3 Capability Phasing

ABC Mars Xplore 

Enterprise

Exploration Program

Landing Vehicle 

Version 1

Landing Vehicle 

Version 2

Planetary Exploration

1.0 Landing Capability

1.1 Habitat Capability

1.1-1 Habitat Increment 1

1.1-2 Habitat Increment 2

Habitat Capability Pkg 3.1

Habitat Capability Pkg 3.2

Mars Exploration 

Projects & 

Capabilities
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Schedule Adjustment Closes Gap
Changing the Portfolio further to achieve proper balance

Without a good model of the Enterprise, it can be very difficult to discern impacts due to changes in a Portfolio

Adjusting milestone to 
the left closes the gap

Gap closed

PV-2 Project Timelines

CV-3 Capability Phasing

Habitat Capability Pkg 3.1

Habitat Capability Pkg 3.2

ABC Mars Xplore 

Enterprise

Exploration Program

Landing Vehicle 

Version 1

Landing Vehicle 

Version 2

Planetary Exploration

1.0 Landing Capability

1.1 Habitat Capability

1.1-1 Habitat Increment 1

1.1-2 Habitat Increment 2
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Strategic Views in UAF Provide Crucial Insights
Drivers, Challenges & Opportunities are Key to conducting Portfolio Management

Enterprise Architecture models and views can serve to provide decision makers with the 

information about the rather complex situations to be encountered

✓ Drivers

✓ Challenges

✓ Opportunities

Effects

These provide the 

proper justification 

for new & improved 

Capabilities
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An Enterprise Architecture Model can be a Key Enabler for 

Enterprise Transformation

UAF can be a key enabler for helping do successful enterprise transformation

DRIVERS OUTCOMES

Portfolio (Now) Portfolio (Future)

Has Desires

Enterprise
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The Enterprise Mindset…

Outcomes for an Enterprise are very complex and are shifting over time. However, you must be 

eternally mindful of the various Drivers in the environment, which are changing constantly…

EnterpriseDRIVERS OUTCOMES

SystemINPUTS OUTPUTS
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Enterprise Modeling Ontology



46

Summary & 

Overview

Standards

Strategic

Operational

Services

Resources

Personnel

Security

Projects

Actual Resources

Iterative Analysis of 

Alternatives and Trades at 

each domain handoff

Verification, Validation and 

Assessment of Implementations

Stakeholders, needs, strategic opportunities, 

driving problems and issues

Strategy, objectives, desired capabilities, 

phasing structure, MOEs and roadmaps

Operational MOPs, taxonomy, activity flows, 

sequences, states, and information exchanges

Service agreements, partnerships, 

and external service dependencies

Physical resources, TPMs, function flows, 

sequences, states, and data exchanges

Standards profile and forecast

Human resources, knowledge and skills, 

positions, roles, and responsibilities

Risks, threats, operational and resource 

mitigations, security enclaves and policies

Integrated deployment schedule 

with delivery milestones

Validation, verification, deployment 

tracking, and use of employed resources

Implementation of 

Operational Elements
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Changing the Portfolio in Response to New Drivers & Challenges
The Enterprise Architecture serves as the foundation for understanding impact of changes
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Modeling 

Language

Architecture 

Framework

Modeling 

Profile

Modeling 

Methodology
Modeling 

Patterns

Modeling 

Templates

• Viewpoints

• View Specifications

• Domain Metamodel

• Syntax

• Notation

• Semantics

Architecture 

Models Architecture 

Views

Modeling 

Workflow

Architecture 

Description

Ontology

EA Guide
Language

Unified Architecture Framework
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Key Enterprise Elements
Managing the Enterprise Portfolio to Maximize Mission Impact

Keeping our focus on the most important dimensions of the Enterprise Total Solution

Strategic 

Drivers

Strategic & 

Enterprise 

Challenges

Capabilities 

& Effects

Portfolio & 

Solution Elements

Strategic 

Missions & Initiatives

Operational 

Performers & Activities
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BACKUP
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Enterprise Architecture Guide for UAF
Standardizing the Modeling Workflow 
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Actual State

Capability

Enterprise 
Vision

Enterprise 
Goal

View

Viewpoint

Architectural 
Description

[frames]

[Governed by]

[Has]

... and has a 
purposeful endeavor

Driver

Challenge

Opportunity

Presented 
by

Motivated by

Impacted by Influences

Risk
Affects

Enterprise Phase
Whole Life 
Enterprise

The 
Enterprise

describes the architecture 
to transform

Concern

Actual Effect

Actual 
Outcome

Motivated by

Actual State

Actual Resource

Actual Organizational Resource

Capability

Enterprise 
Vision

Enterprise 
Goal

View

Viewpoint

Architectural 
Description

Actual Strategic Phase
[assigned to]

[defined for]

Phases

Concern 
[applies to]

[frames]

[Governed by]

[Has]

Actual 
Project 

Fielded Capability

Actual 
Responsibility

Actual Responsible Resource
Stakeholder 

concern

and has a 
purposeful 
endeavor

Driver

Challenge

Opportunity

Presented 
by

Motivated by

Impacted by Desires

Risk
Affects

Actual 
Person

Actual 
Post

Actual 
Organization

Enterprise Phase
Whole Life 
Enterprise

Structural or 
Temporal whole-part

An 
Enterprise

describes the 
architecture to 

transform

References

Concern

Actual Effect

Achieves

Actual 
Outcome

Motivated by
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UAF Conceptual Schema
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Drivers and Outcomes for the Enterprise
From the Theory of Enterprise Transformation (Rouse 2005)

Source:  Rouse, W.B., 2009. “Engineering the enterprise as a system.” (Chapter 10) In Sage, Andrew P. and William B. Rouse 

(Eds.), Handbook of Systems Engineering and Management, (Chapter 10), 2nd edition. John Wiley & Sons, 2009. FIGURE 

10.3. Also in: Fig 2, “A Theory of Enterprise Transformation,” William Rouse, Systems Engineering Journal, Vol 8, No 4, 2005

Drivers

• Demand
• Competition
• Laws
• Regulations
• People
• Technology
• Investment
• Revenues

Outcomes

• Products
• Services
• Revenues
• Earnings
• Share Price
• Market Share
• Jobs
• Innovation

Enterprise 
State

Work 
Processes
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Effects Based Operations*
Mission Effects are what justify the Capabilities, Activities & Functions

Mission Effects
Achieved through

Tasks

Accomplished with

Activities

Supported by

People

Performed by

Use and operate

Capabilities

Accomplished with

Functions

Supported by

Systems

Performed by

* See https://en.wikipedia.org/wiki/Effects-based_operations
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Challenges & Opportunities for Transformation

60

Drivers

• Demand
• Competition
• Laws
• Regulations
• People
• Technology
• Investment
• Revenues

Outcomes

• Products
• Services
• Revenues
• Earnings
• Share Price
• Market Share
• Jobs
• Innovation

Enterprise 
State

Work 
Processes

Challenges Capabilities

Effects

Opportunities

Risks

Performers

Activities

Resources

Functions

Capabilities
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S
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Architecture Tier Examples

1. Community / 

Domain 

Defense, Intelligence, Space Exploration, 

Earth Observation, Transportation, Commerce

2. Department / Office / 

Administration 

DOD, DOC, DOT, IRS, NASA, NOAA, FAA, 

FBI, National Security Council, White House

3. Command / Service / 

Agency (CSA) 

Human Exploration, USSF, SMC, Air Force, 

Navy, National Weather Service, STRATCOM

4. Mission / Capability 

Area (MA/CA) 

Lunar Mission, Launch, Missile Defense, 

Weather, Satcom, PNT, Air Traffic Control

5. Program / Node / 

Network 

Artemis, International Space Station, GBSD, 

MilSatCom, GPS, AFSCN, DSN, AOC

6. Project / System / 

Segment

SLS, Orion, Lunar Lander, Lunar Habitat, 

Minuteman III, GPS Enterprise Ground

SysML and UAF are intended for modeling Systems and Enterprises, respectively, 
… so they can and should complement one another

Architecture Tiers
UAF is most relevant at Tiers 4 and above…

E
n

te
rp

ri
s
e
s
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Architecture Tier Examples

1. Community / 

Domain 

Defense, Intelligence, Space Exploration, 

Earth Observation, Transportation, Commerce

2. Department / Office / 

Administration 

DOD, DOC, DOT, IRS, NASA, NOAA, FAA, 

FBI, National Security Council, White House

3. Command / Service / 

Agency (CSA) 

Human Exploration, USSF, SMC, Air Force, 

Navy, National Weather Service, STRATCOM

4. Mission / Capability 

Area (MA/CA) 

Lunar Mission, Launch, Missile Defense, 

Weather, Satcom, PNT, Air Traffic Control

5. Program / Node / 

Network 

Artemis, International Space Station, GBSD, 

MilSatCom, GPS, AFSCN, DSN, AOC

6. Project / System / 

Segment

SLS, Orion, Lunar Lander, Lunar Habitat, 

Minuteman III, GPS Enterprise Ground

SysML and UAF are intended for modeling Systems and Enterprises, respectively, 
… so they can and should complement one another

Architecture Tiers
For the Space Exploration Domain…

E
n

te
rp

ri
s
e
s
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Multi-Tier Enterprise Modeling
Only use the steps needed for each level and situation
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ISO 42020 – Architecture Processes
EA Guide focus on “elaboration” of architecture with Models & Views
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Architecture Used by Other Processes
Governance & Management as a Basis for Enterprise Decisions

Architecture
Evaluation

Architecture Conceptualization

Architecture 
Elaboration

Architecture 
Governance

Architecture 
Management

Architecture Enablement

Governance 
Directives & Guidance

Management 
Instructions & Guidance

Management 
Plans & Status

Execution 
Plans & Status

Enablement 
Requests & FeedbackArchitecture 

Process Enablers

ISO/IEC 42020 –
Architecture 

Processes

Reference models, 

patterns, templates, etc and 

models for architecture repository

Architecture views 

for decision 

support

Architecture views for 

management reviews 

& assessments

Architecture 

Repository
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UAF Specification at a glance

Copyright © 2022  OMG. All rights reserved.   

Specification

View specifications organized in 

domains and model kinds (Grid)
Taxonomy

Structure &
Connectivity

Behavior Information Parameters Constraints Roadmap Traceability

Strategic

Operational

Services

Personnel
&

Resources

Security

Projects

Standards

Requirements 1

Domain MetaModel

(DMM)
Project 
actual 

Actual Project 
milestone

Is part of
Provides status 

for

Enterprise goal

Capability

Depends on/ 
specializes/ 

contains

Is a goal 

of

Contains

Exhibits

Enterprise vision

Is a vision 

for

Actual enterprise 
phase

Maps to

Service 
specification

Consumes

Service interface

Service port

Defines

Has

Standard

Requirement

Links to all 

elements

Links to all 

elements

Affects resource and 
operational elements

Measurement

RiskSecurity control

Mitigates

Links to all 

elements

Information 
elementData element

Data model

Contains Contains

Owned 
by

Owned 

by

Defines

Operational 
activity

Specializes

/ contains

Operational 
interface

Operational port

Has

Maps to

Operational agent

Operational 
performer

Operational 
architecture

Operational

exchanges

Known resource

Performs

Actual resource

implements

Classified by

Implements

Exhibits

Function

Performs

Contains

Implements

Resource port Resource 
interface

Defines

Has

Fielded 

capability

Actual organisational resource

Actual 

person
Actual post

Actual 

otganisation

Specializes/ 
contains

Resource 

exchanges

Resource performer

Resource architecture Organisational 
resource

Capability configurationSystem

Physical resource

Resource 

artefact
Software

Natural 

resource

Organization

Person

Post

ResponsibilitySecurity 

enclave

Known 
resource

2

UAF Profile Modeling Language 

based on SysML (UAFP) (UAFML)

3

UAF v1.2 

EA Guide 

(EAG)

4
UAF v1.2 
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Modeling 

Language

Architecture 

Framework

Modeling 

Profile

• Viewpoints

• View Specifications

• Domain Metamodel

• Syntax

• Notation

• Semantics

Modeling 

Methodology

Modeling 

Workflow

Architecture 

Models Architecture 

Views

Architecture 

Description

Language 

Metamodel

Framework 

Metamodel

Modeling 

Patterns

Modeling 

Templates



68

• The domains present a logical and 

systematic flow of architecting precepts

I. Concerns drive a strategic plan

II. The strategic plan deploys capabilities in 

phases addressing gaps and shortfalls

III. Capabilities are implemented by 

conceptual operations

IV. Concepts are implemented through 

services, resources and personnel

V. Resources comply with standards

VI. Risk and threats are mitigated through 

security & protection controls 

(of resources and operations)

VII. Requirements are understood 

and communicated

VIII. Plans deliver the resources

IX. Resources are verified

UAF provides a complete set of modeling domains as basis for 
defining the necessary architecture views of an Enterprise

Progression from Architecture Drivers to Implementation and 

Deployment of Capabilities



69

Modeling 

Language

Architecture 

Framework

Modeling 

Profile

Modeling 

Methodology
Modeling 

Patterns

Modeling 

Templates

• Viewpoints

• View Specifications

• Domain Metamodel

• Syntax

• Notation

• Semantics

Architecture 

Models Architecture 

Views

Modeling 

Workflow

Architecture 

Description

Language 

Metamodel

Framework 

Metamodel

PROFILE
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UAF Key Elements
Focus on top tier for Portfolio Management 

Need to examine various factors that will help identify which Capabilities in the 

Enterprise have gaps and shortfalls with respect to causing desired Effects

✓ Drivers

✓ Challenges

✓ Opportunities

Effects

These provide 

the proper 

justification 

for Capabilities
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Conceptual Schema for Architecture-Based 

Strategic Technical Planning
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Challenges & Opportunities to be Identified 

for Achieving Enterprise Transformation

Drivers

• Demand
• Competition
• Laws
• Regulations
• People
• Technology
• Investment
• Revenues

Outcomes

• Products
• Services
• Revenues
• Earnings
• Share Price
• Market Share
• Jobs
• Innovation

Enterprise 
State

Work 
Processes

Challenges Capabilities

Effects

Opportunities

Risks

Performers

Activities

Resources

Functions

Capabilities

GoalsStates

Risks
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• Driver (from driving documents)

– Thing that forces to work or act

– That which urges you forward

• Enterprise State

– Condition with respect to 

circumstances or attributes

• Outcome

– Something that happens or is produced 

as the final consequence or product

• Capability

– Ability to do something

• Effect

– A phenomenon that follows and is 

caused by some previous phenomenon

• Challenge

– A demanding or stimulating situation

– A call to engage in a contest or fight

• Opportunity

– A possibility due to a favorable 

combination of circumstances

• Risk

– A source of danger

– A possibility of incurring loss or 

misfortune

• Mission

– special assignment or operation 

assigned to a person or group intended 

to carry out specific objectives
– Note: Bring this back from UPDM

Model Elements for Portfolio Management
Enhancements needed in the DMM

Note: Only the Capabilities and Work Processes (ie, operational activities) 

are in DMM. Other elements need to be added.
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Example Elements
These things provide the context in which Capabilities are assessed

• Anticipate rapid emergence of competitor’s capabilities and service offerings

• Preserve and protect supply chain by investing in modernization efforts

• Maintain continuity during degraded or disrupted environments
Drivers

• Access to and awareness of new and emerging markets and customers

• Availability of necessary industrial base capabilities and skills

• Explosion in data from large variety of sources and methods
Challenges

• Social media products and services are proliferating

• Ubiquitous broadband connectivity from space 

• Everything is Web-enabled – connections are low cost and easy to make
Opportunities

• Customer satisfaction with our products and services

• Increasing value for shareholders and owners

• Continuous peace and prosperity
Effects

• Security and well being of our customers and end users

• Affordable access to high-value products and services

• Value delivery in a timely and effective manner
Outcomes
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Example Measures
These things are measurable

• Extent of relevance to the enterprise

• Degree of urgency

• Extent of difficulty 
Drivers

• Extent of difficulty

• Degree of criticalityChallenges

• Probability of happening

• Magnitude of consequence if this comes aboutOpportunities

• Measure of Effect (MOE)

• Measure of Success (MOS)Effects

• Probability of happening

• Magnitude of impact on enterprise success or viabilityOutcomes
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What should motivate the Enterprise to change?
Drivers & Challenges for basis for identification of Opportunities

Actual State

Capability

Enterprise 
Vision

Enterprise 
Goal

View

Viewpoint

Architectural 
Description

[Addresses]

[Governed by]

[Has]

... and has a 
purposeful endeavor

Driver

Challenge

Opportunity

Presented 
by

Motivated by

Impacted by Desires

Risk
Affects

Enterprise Phase
Whole Life 
Enterprise

The 
Enterprise

describes the architecture 
to transform

Concern

Actual Effect

Actual 
Outcome

Motivated by
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Sample View

Strategic Motivation View:  Drivers→ Challenges→

Opportunities→ Goals→ Outcomes
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Sample View

Strategic Motivation View:  Drivers→ Challenges→

Opportunities→ Goals→ Outcomes
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Strategic Motivation 

View:  Drivers→

Challenges→

Opportunities→

Goals→ Outcomes
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Sample View

Strategic States: Capability Effects View (Opportunities→ Capabilities→ Phases→

Effects→ Outcomes)
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Sample View

Strategic States: Capability Effects View (Opportunities→ Capabilities→

Phases→ Effects→ Outcomes)
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Strategic States: 

Capability Effects View 

(Opportunities→

Capabilities→

Phases→ Effects→

Outcomes)



84

Sample View of Value Chain

Strategic States View:  Missions→ Effects→ Conditions→ Resources (Architectures, 

Artifacts, Technologies, Software)
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Sample View of Value Chain

Strategic States View:  Missions→ Effects→ Conditions→ Resources (Architectures, 

Artifacts, Technologies, Software)
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Strategic States View:  

Missions→ Effects→

Conditions→ Resources 

(Architectures, Artifacts, 

Technologies, Software)
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Sample View of Value Chain
Strategic States Mock-Up (Desired Look & Feel)
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Sample View

Strategic Traceability View

Mapping Challenges to 

Operational Activities

Mapping Drivers & Challenges 

to the Rest of the Architecture
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Sample View

Strategic Traceability View
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Sample View

Strategic Traceability View

Enduring Tasks

Capabilities

Operational Activities

Operational Performers
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Sample View

Strategic Traceability View

Drivers

Challenges

Enduring Tasks

Capabilities
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Challenges & Opportunities Identified for Achieving 

Enterprise Transformation

Drivers

• Demand
• Competition
• Laws
• Regulations
• People
• Technology
• Investment
• Revenues

Outcomes

• Products
• Services
• Revenues
• Earnings
• Share Price
• Market Share
• Jobs
• Innovation

Enterprise 
State

Work 
Processes

Challenges Capabilities

Effects

Opportunities

Risks

Performers

Activities

Resources

Functions

Capabilities

GoalsStates

Risks
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Conceptual Schema for Architecture-Based 

Strategic Technical Planning
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New UAF Model Elements in Support of 

Enterprise Portfolio Management

✓ Drivers

✓ Challenges

✓ Opportunities

Effects

These provide 

the proper 

justification 

for Capabilities



95
© 2022 The Aerospace Corporation

Enterprise Architecture Based 

Portfolio Management: 
Architectural Queries of the 

EA Portfolio Model

James N Martin
Distinguished Engineer
Aerospace Corporation

Systems Engineering Forum

15 February 2022



96

Sample Query of EA Model
Continued Operations (Driver) Impact Map

Driver→ Challenge→ Risk→ Goal→ Outcome



Sample Query of EA Model
Continued Operations (Driver) Impact Map

Driver→ Challenge→ Risk→ Goal→ Outcome
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Sample Query of EA Model
Industrial Base Availability (Challenge) Impact Analysis Diagram

Driver→ Challenge→ Opportunity
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Sample Query of EA Model
Web-based Connectivity (Opportunity) Impact Analysis Diagram

Driver→ Challenge→

Opportunity→ Capability→

Effect→ Outcome



100

Sample Query of EA Model
Web-based Connectivity (Opportunity) Impact Analysis Diagram

Driver→ Challenge→ Opportunity→

Capability→ Effect→ Outcome
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Sample Query or Report
Web-based Connectivity (Opportunity) Impact Analysis Diagram

Driver→ Challenge→ Opportunity→

Capability→ Effect→ Outcome
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Sample Query of EA Model
Risk 2 (Actual Risk) Impact Analysis Diagram

Opportunity→ Risk→ Goal
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Sample Query of EA Model
Risk 2 (Actual Risk) Impact Analysis Diagram

Driver→

Challenge→

Opportunity→

Risk→ Goal



Sample Query
Risk 2 (Actual Risk) 

Impact Analysis 

Diagram

Driver→

Challenge→

Opportunity→

Risk→ Goal
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Sample Query of EA Model
Challenges to Project Thread - Diagram View

Challenges→ Opportunities→

Capabilities→ Projects
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Sample Query of EA Model
Challenges to Project Thread - Relationship Map View 

Challenges→ Opportunities→

Capabilities→ Projects
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Sample Query of EA Model
Challenges to Project Thread - Relationship Map View 

Challenges→ Opportunities→

Capabilities→ Projects
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Sample Query of EA Model
Challenges to Project Thread - Relationship Map View 

…→ Capabilities→ Projects
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Sample Query of EA Model
Project to Challenges Thread – Table View (Meta-chains)



Sample Query of EA Model
Project to Challenges Thread – Table View (Meta-chains) – (Expanded View)
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Sample Query of EA Model
Challenges to Project Thread – Table View (Meta-chains)



Sample Query of EA Model
Challenges to Project Thread – Table View (Meta-chains) - Expanded


